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Welcome to Virtual PC for Mac 5.0—a sophisticated 
software program that lets you run one or more fully
functional, emulated PCs on your Macintosh.

This Getting Started Guide provides the information you need
to install, configure, and get started with Virtual PC. 

If you are new to Virtual PC, take a few minutes to look through
the section “Touring Virtual PC” on pages 6 to 15. It provides
an overview of the key features and concepts you need to 
successfully use the product.

If you are already familiar with Virtual PC, see the section
“What’s New in Virtual PC for Mac 5.0?” on page 16 for a
summary of the new features in this version.

Additional information

In addition to this guide, you have two other important sources
of information about Virtual PC:

Help
Built-in Help provides detailed
information about each feature
and option in Virtual PC. 
(See page 25.)

Online support at 
http://www.connectix.com/support/ 
Connectix Care offers up-to-the-minute 
information and trouble-shooting assistance.
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5Introduction

About system requirements

To install and run Virtual PC for Mac 5.0, you must have a
native G3 or G4 Macintosh running Mac OS 9.1 (or later) or
Mac OS X (version 10.1 or later). You must also have sufficient
free hard disk space and RAM. (The details for these requirements
are on page 17.)

IMPORTANT: If you have both Mac OS X and Mac OS 9
installed on your computer and if you want to run Virtual PC
in either operating system, you should install Virtual PC
while you are running Mac OS X.

Connectix support

If you need assistance with Virtual PC, first check Help and this
manual. For further assistance, please visit the support section
of the Connectix Web site at:

http://www.connectix.com/support/

This support section includes features such as:

• Knowledge Database 

• Answer Path

• Online Forums

• Product Support Downloads

It also has information about contacting Connectix directly 
for support.
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Touring Virtual PC
Virtual PC for Mac creates a software emulation of a fully functional PC 
on your Macintosh. This emulation is called a “virtual machine” or a 
“virtual PC.”

A virtual machine
appears in its own
window on the
Macintosh desktop.
You can run more
than one virtual
machine at the 
same time.

You can install and
run off-the-shelf
PC applications on
a virtual machine. 
A PC application 
can use Macintosh
peripherals such as
printers, modems,
CD-ROM drives, 
and USB devices.

You can copy and
paste between 
applications running
on a virtual machine
and the Macintosh.
You can also drag and
drop files and folders
between the
Macintosh and a 
virtual machine, or
share a folder on 
the Macintosh with 
a virtual machine.

A virtual machine fully emulates the key hardware features of a standard PC, including
Sound Blaster 16 sound, the S3 Trio 32/64 video card, Ethernet networking, and the
Pentium II™ with MMX®.
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1 Settings 
Each virtual machine has its own settings that let you 
control various options and behaviors of the emulated PC. 
For more information about Settings, see page 14.

2 A hard disk image file for Drive 1
A hard disk image file on the Macintosh functions as the
"built-in" hard disk for an emulated hard drive on a virtual
machine. There are three hard drives on a virtual machine.
Drive 1 is the C or boot drive.

The full version of Virtual PC for Mac ships with one hard disk
image with an operating system already installed. You can purchase
Connectix OS Packs that provide additional hard disk images with
pre-installed operating systems. You can also create a hard disk
image from scratch and then install your own copy of an operating
system on it.

3 An operating system
An operating system must be installed on the hard disk 
image file assigned to Drive 1 so that the virtual machine 
can start up. 

You can run any one of a number of operating systems 
on a virtual machine, including Windows 95, Windows 98,
Windows 2000, Windows XP Home, Windows XP
Professional, or Linux.

Components of a virtual machine

A virtual machine has three basic components:
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The Virtual PC List window
When you start up Virtual PC, the Virtual PC List window appears 
on your desktop. This window is the “dashboard” for Virtual PC.

Create a new virtual machine.

See and modify the settings for a virtual machine.
You can also access settings for a virtual machine from
the Virtual PC Toolbar. For more information about
Settings, see page 14.

Delete the settings for a virtual machine.
You only delete the settings, not any hard disk images
assigned to the virtual machine.

Start up (or shut down) a virtual machine.
You can also start up a virtual machine by double-clicking 
it in the list.

Use a contextual menu.
Hold down the Control key and select a virtual machine
on the list to display a contextual menu. The items on 
the menu vary according to the state of the virtual
machine.
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The Virtual PC Toolbar appears in the bottom left corner 
of a window displaying a virtual machine. Clicking an icon
on the Toolbar displays a contextual menu.

The Virtual PC Toolbar

Hard Drive
Open Drive settings or Virtual Disk Assistant, a
utility that lets you modify or create hard disk
image files or floppy disk image files. Virtual Disk
Assistant is also available from the Window menu.

CD/DVD
Open CD/DVD settings, or capture or uncapture
a CD or CD disk image file. If you place a CD in
the CD-ROM drive of your Macintosh when a
virtual machine is running and is frontmost, the
CD is automatically captured (mounted) on the
virtual machine. You can uncapture it using this
icon or the Drives menu. You can drag a CD
disk image file to this icon to capture it.

Floppy
Open Floppy settings, or capture or uncapture a
floppy disk or floppy disk image file.  If your
Macintosh does not have a floppy drive and you
need to mount a floppy disk on a virtual machine,
you must use a floppy disk image file. You can
drag an image file to this icon to capture it, or
use the Drives menu.

Shared Folders
Open Shared Folders settings, or share a folder.

Network
Open Network settings.

USB
Open USB settings.

VPC Additions
Install Additions, or get information on the
virtual machine. Additions are software mod-
ules that enable integration between a virtual
machine and your Macintosh. You should
install Additions when you create a hard disk
image from scratch and install your own copy
of an OS on it.
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Virtual PC menus in Mac OS X

Preferences   

Open Preferences that let you set global 
behaviors for Virtual PC. For example, you 
can set options to:
• Control Alerts.
• Pause virtual machines in the background.
• Restore virtual machines automatically 

when you launch Virtual PC.
• Control Full Screen Mode.
• Mute sounds.

Hide Virtual PC  / Hide Others / Show All  

Hide or show Virtual PC and other applications.

Save All and Quit

Save the state of all virtual machines and quit
Virtual PC.

Settings

Open the settings for a virtual machine.

Here is an overview of the Virtual PC menus in Mac OS X.

Close

Close the active window.

Save and Close

Save the state of a virtual machine and close 
its window.

Get Info

Get information about a virtual machine. This
includes RAM usage.
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Full Screen Mode

Display a virtual machine so that it takes up
the entire screen. (You can control the exact
behavior of this command using the
Preference for Full Screen Mode.)

Pause

Pause or resume a virtual machine.

Hide

Hide a virtual machine.

Restart

Restart the OS on a virtual machine.

Shut Down

Shut down or start up a virtual machine.

Eject Disc / Uncapture Disc / Capture CD
Image / Capture Disc

Manage CDs and DVDs. You can also capture
or uncapture a CD or DVD from the Toolbar.

Eject Floppy / Uncapture Floppy Image /
Capture Floppy Image / Capture Floppy

Manage floppy disks. You can also capture or
uncapture a floppy from the Toolbar.

Share Folder

Choose a folder on the Macintosh for sharing
with a virtual machine.

Minimize Window

Minimize the frontmost window.

Virtual PC List

Display the list of available virtual machines.

Virtual Disk Assistant

Open the Virtual Disk Assistant utility. Virtual
Disk Assistant lets you modify or create hard
disk images or floppy disk images.

Pause Others / Show All / Cycle Through PCs

Control the behavior of several virtual
machines at the same time.

List of virtual machines that are started up

Make the window for a virtual machine the
frontmost window.
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Virtual PC Menus in Mac OS 9

Preferences 

Open Preferences that let you set global 
behaviors for Virtual PC. For example, you 
can set options to:
• Control Alerts.
• Pause virtual machines in the background.
• Restore virtual machines when you launch 

Virtual PC.
• Control Full Screen Mode.
• Mute sounds.

PC Settings 

Open the settings for a virtual machine.

Full Screen Mode

Display a virtual machine so that it takes up
the entire screen. (You can control the exact
behavior of this command using the
Preference for Full Screen Mode.)

Pause / Resume

Pause or resume a virtual machine.

Hide

Hide a virtual machine.

Restart

Restart the OS on a virtual machine.

Shut Down 

Shut down or start up a virtual machine.

Here is an overview of the Virtual PC menus in Mac OS 9.

Close

Close the active window.

Save and Close

Save the state of a virtual machine and close 
its window.

Get Info

Get information about a virtual machine. 
This includes RAM usage.

Save all and Quit

Save the state of all virtual machines and quit
Virtual PC. 

Quit

Quit Virtual PC.
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Eject Disc / Uncapture Disc / Capture CD
Image / Capture Disc

Manage CDs and DVDs. You can also capture
or uncapture a CD or DVD from the Toolbar.

Eject Floppy / Uncapture Floppy Image /
Capture Floppy Image / Capture Floppy

Manage floppy disks. You can also capture or
uncapture a floppy from the Toolbar.

Share Folder

Choose a folder on the Macintosh for sharing
with a virtual machine.

Virtual PC List

Display the list of available virtual machines.

Virtual Disk Assistant

Open the Virtual Disk Assistant utility. Virtual
Disk Assistant lets you modify or create hard
disk images or floppy disk images.

Pause Others / Show All / Cycle Through PCs

Control the behavior of several virtual
machines at the same time.

List of virtual machines that are started up

Make the window for a virtual machine the
frontmost window.
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About Settings
Specify the name of the virtual machine.

Set the amount of RAM for the virtual
machine.

Specify a hard disk image for Drive 1, 
Drive 2, or Drive 3. Drive 1 is also 
known as the C drive or boot drive.

Set the Undo Drives option. (See page 15.)

Enable or disable booting from a floppy disk.

Designate folders for sharing between the 
virtual machine and the Macintosh. You can
also automatically share local volumes, 
network volumes, and removable media.

Set Macintosh equivalents for the PC right
mouse button.

Set Macintosh equivalents for COM1 Port and
COM2 Port. You can also send the virtual
machine port output to a text file.

Select USB devices for exclusive use by the 
virtual machine. A Macintosh USB keyboard,
floppy drive, and mouse are automatically
shared with a virtual machine.

Set Macintosh equivalents for certain PC keys
such as PRINT SCREEN.

Enable or disable booting from a CD. You 
can also set the IDE configurations.

Each virtual machine has its own settings.

Enable or disable networking.
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As you run PC applications on a virtual machine, you 
usually add information to the hard disk image file
assigned to Drive 1 (the boot drive) or to the hard disk
image files assigned to other drives. 

However, you may wish to leave the original state of a
hard disk image file unchanged. (For example, you might
want to run beta software.) 

15Touring Virtual PC

About hard disk image files

If this is the case,
you can enable the
Undo Drives option
in the settings for 
a virtual machine. 
(By default, this
option is off.)

Shut Down

Save PC’s state—save the current state of the virtual machine.

Shut down—shut down the OS running on the virtual machine.

Turn off PC—turn off the virtual machine. This may result in data loss. 
It is the equivalent of unplugging a PC without shutting down the OS.

Undo Drives

Discard hard drive changes—
delete the separate file that contains
the changes.

Save hard drive changes—
incorporate the changes to the original
hard disk image file. 

Carry forward undoable changes—
keep the separate file with the
changes. Do not modify the original
hard disk image file.

When you shut
down the virtual
machine, you have
several options:

Now all changes to the disk image file are written to a 
separate file, leaving the original disk image file untouched.
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What’s New in Virtual PC for Mac 5.0?
Here are the key new features:

• Single application that runs under both Mac OS 9.1 
(or later) and Mac OS X (version 10.1 or later).

• Support for Windows XP Home and Windows XP
Professional.

• Undoable hard disk images. (See page 15 for the details.)

• Support for DVD data (not DVD video).

• Automatically share Zip, Jaz, CD, and DVD drives. Also share
network volumes and drives with non-removable disks.

• Use an ISO CD image as a virtual CD.

• Networking between virtual machines running on the same
Macintosh using the Virtual Switch option under Mac OS X.
(See page 23.)

• Support for multiple processors in Mac OS X.

• Extended mapping between Macintosh keyboard and 
standard PC keys.

• Information about a virtual machine available from the File
menu.
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The exact requirements for free disk space and RAM depend on the operating 
systems running on a virtual machine and on your Macintosh.

Virtual machine OS Free disk space OS 9 Minimum RAM OS X Minimum RAM 

DOS 260 MB 64 160

Windows 95 500 MB 96 192

Windows 98 1 GB 128 192

Windows Me 1 GB 160 192

Windows 2000 1.5 GB 192 256
Professional

Windows NT 4.0 500 MB 128 192
Workstation

Windows XP Home 2 GB 192 256

Windows XP Professional 2 GB 192 256

Linux 1 GB 128 192

Before you install Virtual PC for Mac
5.0, note these system requirements:

• Any native G3 or G4 Macintosh with
a CD-ROM drive.

• Mac OS 9.1 (or later), or Mac OS X
(version 10.1 or later).

• To run Virtual PC in Mac OS X, a 
400 MHz or faster processor.

IMPORTANT: If you want to run Virtual
PC in either Mac OS 9 or Mac OS X,
you should install the program in 
Mac OS X. (If you install the program
in Mac OS 9, and run it in Mac OS X,
you lose some functionality.)

17Installing Virtual PC 5.0

Installing Virtual PC for Mac 
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Before you start
Please have the following information on hand before you
start installation:

• The serial number for your copy of Virtual PC for Mac. You
can find it on the serial number card or in the order confi-
mation e-mail from the Connectix eStore.

• If you are installing in Mac OS X, an administrator name and
password or phrase.

Installation steps
The following installation steps apply if you are installing 
Virtual PC for the first time or upgrading from an earlier version:

IMPORTANT: If you have an earlier version of Virtual PC on
your Macintosh, follow these steps before you install 
Virtual PC 5.0:

1. Launch the earlier version of Virtual PC.

2. Shut down the operating systems on all virtual machines.
(Do not shut down the virtual machines in a saved state.)

3. Quit the earlier version of Virtual PC.

Your legacy virtual machines will be automatically imported
into Virtual PC for Mac 5.0 under certain conditions.
Otherwise, after installation, you can import your legacy 
virtual machines by hand. (See page 20.) 

Follow these steps:

1. Insert the Virtual PC CD (if you have one).

2. Double-click the Virtual PC Installer.3

3. Read the licensing agreement and click Accept.

4. Look over the Read Me information and click Continue.

5. Choose Easy Install to perform a standard installation.

You can use Custom Install to install Virtual PC in a 
different language.

6. Click Install.
The Installer copies the following items to your hard drive
from the Virtual PC CD:

— Virtual PC for Mac 5.0 application.

— A hard disk image file with a PC operating system
installed (for first-time installation only).

— Virtual PC Read Me.

— Extras folder.

7. Click Quit to quit the installer.

It is not necessary to restart your Macintosh.
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Now follow these steps to personalize and register your copy of
Virtual PC. (You need to register to receive Connectix support.) 

1. If necessary, open the Virtual PC folder on your Macintosh
and double-click the Virtual PC application.

2. Follow the directions to personalize and register your copy
of Virtual PC. (You need the serial number to complete this
process. It is located on the serial number card or in the
confirmation e-mail from the Connectix eStore.)

3. Click Done.

If you are upgrading from an earlier version of Virtual PC and 
if no legacy virtual machines have been imported into Virtual
PC 5.0, the PC Setup Assistant appears:

Follow the directions for “Importing by hand” on page 20.

19Installing Virtual PC 5.0

If you are installing Virtual PC for the first time or if legacy 
virtual machines have been imported into Virtual PC 5.0, the
Virtual PC List window appears:

Congratulations! You have successfully installed Virtual PC.

To set up your system so that you can use the same virtual
machines in both Mac OS X and Mac OS 9, follow the 
instructions on page 21. 

Mac OS X Mac OS 9
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If you upgrade from version 4.0 or the Test Drive version
of Virtual PC, your legacy virtual machines are usually
imported automatically into Virtual PC for Mac 5.0 and
appear in the new Virtual PC List window. If necessary,
however, you can import legacy virtual machines “by
hand” into Virtual PC 5.0 from any earlier version of the
program. 

IMPORTANT: Before you start, you should open your earlier
version of Virtual PC and shut down the operating systems
on all your legacy virtual machines. Make a note of the 
settings for each virtual machine, as well as the name and
location of the hard disk image files assigned to it. (By
default, this location is the folder that contains the earlier
version of Virtual PC.) You may wish to copy or move these
hard disk image files to the new Virtual PC 5.0 folder.

Follow these steps:

1. If necessary, launch Virtual PC for Mac 5.0 and click New
in the Virtual PC List window.

The PC Setup Assistant appears.

2. Enter a name for the “new” virtual machine and click the
right arrow.

You might choose a name indicating the operating system
installed on the legacy boot disk image file.

3. Choose the Guide Me option and click the right arrow.

4. Select the operating system installed on the legacy boot
disk image file. 

5. Click the right arrow.

6. Select the No option for Memory Settings and click the
right arrow.

7. Choose the Select an existing drive image option and
click the right arrow.

8. Click Select Disk, and navigate to and select the legacy hard
disk image file for the boot drive (Drive 1) in the virtual
machine.

Alternatively, you can drag the file to the Selected Disk field.

9. Click the right arrow and complete the setup process.

10. Click Done.

The Virtual PC List window reappears with the new virtual
machine listed.

11. Now select the new virtual machine in the list, click
Settings, and make any changes you require.

If your legacy virtual machine has disk image files assigned
to the D or E drives, you can now assign those files to 
Drive 2 or Drive 3.

You may want to increase the virtual machine RAM.

You can set the Undo Drives option to protect the original
hard disk image files. (See page 15 for details.)

Finally, repeat these steps for any other legacy virtual machines
you want to import into Virtual PC for Mac 5.0.

Importing by hand
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Running in Mac OS X and Mac OS 9
If you installed Virtual PC for Mac 5.0 in Mac OS X and you
also want to run the program in Mac OS 9 using the same
virtual machines, follow these steps:

1. Restart your Macintosh in OS 9.
In Mac OS X, choose Startup Disk in System Preferences.
Select the System Folder with Mac OS 9 and click Restart.

2. In Mac OS 9, open the Sherlock utility and search for the
folder “Virtual PC 5.0 Preferences” on the partition where
Mac OS X is installed.

The path for this folder is Users/username/Library/
Preferences/Virtual PC 5.0 Preferences where username is
the name of the account you used when you installed
Virtual PC for Mac 5.0 in Mac OS X.

3. Make an alias for this folder by holding down the Option
and Command keys and dragging the folder from the
Sherlock window to your desktop. (Make sure the alias is
called Virtual PC 5.0 Preferences.)

4. Open the Applications folder on the partition where Mac
OS X is installed.

5. Drag the alias into the Virtual PC folder.

NOTE: You might also open the Virtual PC folder and make 
an alias for the Virtual PC application. Put this alias in a 
convenient location for use in Mac OS 9.

You can now use the same virtual machines in Mac OS 9 that
you use in Mac OS X, maintaining the same drive images,
Preferences, settings, and saved states.

Installing Virtual PC 5.0
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Here are some key points about using a virtual machine.

Starting up a virtual machine for the first time 

The first time you start up a virtual machine with a Windows
operating system pre-installed on the hard disk image, you
need to enter the Windows product key or Certificate of
Authenticity (COA) number. This number is located on a card
packaged with your Microsoft Windows manual.

I M P O R TA N T: Keep your Microsoft manual and COA in
case you need to reinstall Windows or Virtual PC. 
You must have this product key to reinstall or 
register your Microsoft software. (You can record it
when you register Virtual PC.)

Installing an application on a virtual machine

You can install a PC application on a virtual machine following
these steps:

1. Start up the virtual machine where you want to install the
application.

2. Insert the installation CD for the PC application in the 
CD-ROM drive of your Macintosh.

3. Follow the installation instructions on the virtual machine.

4. When installation is complete, you can use the Toolbar
contextual menu or the Drives menu to eject the CD.

If your Macintosh does not have a floppy drive and if you want
to install an application from a floppy disk, you need to obtain
a floppy disk image of the actual floppy. You can capture this
disk image on the virtual machine by dragging it to the Floppy
icon on the Toolbar.

The active CD icon on
the Toolbar indicates
that the CD has been
captured by the virtual
machine. 
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23Using a Virtual Machine

Each virtual machine has its own setting for Networking. Shared Networking 
Shared networking lets the virtual machine share the IP
address of the Macintosh. This option works well for stan-
dard networking activities such as browsing the Web, reading
e-mail, or accessing FTP sites, shared printers, or files. You
should configure the OS running on the virtual machine to
“Obtain IP address automatically.”

Virtual Switch
In Mac OS 9, this option allows the virtual machine to have
a fixed IP address distinct from the Macintosh IP address.
(Certain PC applications may require this.) In Mac OS X, this
option lets the virtual machine become a fully functional
network node that can communicate with other virtual
machines running on the same Macintosh, the host
Macintosh itself, or other computers on the network.
Virtual Switch under Mac OS X addresses advanced net-
working needs such as running an HTTP or FTP server with
predefined port numbers or remote login (rlogin).When you run a virtual machine in Mac OS X and it 

is set for Shared Networking, you may receive a message 
saying “A NetBIOS client is already active on this Macintosh.”
This means the Windows Network Neighborhood is not 
visible from the virtual machine. Change the Networking
setting to Virtual Switch to solve this problem.

Networking
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You can print from a virtual machine running Windows 
in three ways: 

• Via the host Macintosh. You can print to a printer directly
connected to the Macintosh or to a printer on the network
that supports printing from your Macintosh.

• Directly to a USB printer assigned to the virtual machine.

• Directly to a Windows printer on the network.

To print via the host Macintosh:

1. Make sure the printer is working from the Macintosh.

2. Open Printers in Windows.

3. Make sure you have the appropriate Macintosh printer
type selected (MacPrinter Inkjet or MacPrinter PostScript).

IMPORTANT: You do not need to install a printer driver on 
the virtual machine.

4. Close Printers and print from an application installed on
the virtual machine via the Macintosh.

To print directly to a USB printer:

1. Open Settings for the virtual machine.

2. Enable USB, and select the USB printer. 

The printer is no longer available to the Macintosh or to
other virtual machines.

3. Install the necessary printer software on the virtual machine.

Follow the instructions included with the printer exactly. 

4. Make sure the newly installed printer is the default printer.

5. Close Printers and print directly from the virtual machine to
the USB printer.

To print directly to a Windows printer on the network:

1. Make sure Networking is enabled for the virtual machine.

2. If necessary, install the driver for the networked Windows
printer on the virtual machine.

Follow the instructions included with the printer exactly. 

3. Make sure the newly installed printer is the default printer.

4. Close Printers and print directly from the virtual machine to
the networked Windows printer.

Printing
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From the Help menu, you can open the built-in Help 
system for Virtual PC for Mac 5.0. It provides comprehensive,
detailed information about features and options of the
program. 

From the Help menu, you can also save a file with troubleshooting
information.

Open the Help window.

Save a text file in the Virtual PC 
folder with current information 
about your virtual machines. 
The file is called “Virtual PC Details.”

You can also click the Help button
when it is available to open Help.

Using Help

Using a Virtual Machine
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When you shut down a virtual machine, you 
have three options:

Save the current
state of the 
virtual machine.

Shut down the OS
running on the 
virtual machine.

Turn off the virtual
machine. This may
result in data loss. It
is the equivalent of
unplugging a PC
without first shut-
ting down the OS.

If you have enabled the Undo Drives option for a virtual
machine, you also have additional choices at the time you 
shut down. See page 15 for the details.

It is a good idea to periodically back up the hard disk image
files for your virtual machines. If you need to recreate a virtual
machine, using the backup disk images can make the process
relatively quick and easy. 

If the Undo Drives option is enabled, you should first shut down
a virtual machine choosing the “Save hard drive changes”
option before you back up.

Since the disk image file can expand to a significant size as you
install applications and create data, you may require large-
capacity media to backup a disk image. (Alternatively, you can
back up just the data you create within the virtual machine.)

Shutting down a virtual machine Backing up a virtual machine
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Here are some other useful features of Virtual PC 
for Mac 5.0. Please consult Help for the details. 

You can:

• Install your own copy of an OS on a virtual machine. 

• Use Virtual Disk Assistant to:

— examine or modify a disk image file.

— create a new hard disk or floppy disk image file.

• Use AppleScript to control the behavior of Virtual PC.

• Use your Palm OS PDA with a virtual machine.

Other features

Using a Virtual Machine
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